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US meat and bone meal trends
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Ruminant meat and bone meal

• Higher cattle weights are not expected to offset production from low head counts

• Price ranges remain wide on ruminant MBM due to mixed to pure beef spread

• Mixed species meat and bone meal has higher supply to demand ratio

• Pure beef meat and bone meal spot supplies have been tight

Porcine meat and bone meal

• Price trends comparable to ruminant meat and bonemeal; ranges tighter

• Prices at the end of 2024 and into 2025 were under negative pressure; even with 

decreased production, depressed soybean meal prices capped gains

• 2025 prices traded below 2024 due to formulation changes – higher focus on 

dollar per protein

• Lower production has kept a floor under the market in 2024 and 2025

• Prices at the end of 2025 and into 2026 higher - diminished production, supportive 
soybean meal prices
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Soybean meal relative price to US animal proteins

• Porcine and ruminant MBM relative to SBM 

trending higher than 2025 and 2024

• Poultry by-product pet grade is in-line with 

other years but less volatile

• Export demand has smoothed out – fewer 

tariff adjustments, active demand overseas
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• Soybean meal relative to SBM is used due to the 
reliability, digestibility, liquidity, and transparent 
pricing

• In 2025 it changed: increased soybean crush, 
biofuel policies, and access to new trade 
regions.

• Soybean meal dominates protein meal volumes 
in the market$250
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Shift to dollar per protein

Variability
Protein sources no longer move in lockstep

Processing, origin, and supply differences 
widened price dispersion

Soybean meal prices increasingly reflect oil 
and crush economics, not protein alone

Tighter feed margins exposed formulation 
shortcuts

$/protein improved cost control and 
formulation accuracy

4

Margins

Digestibility
Growing spread between crude protein and 
digestible amino acid value

New and alternative proteins require pricing 
on usable nutrition, not inclusion rate
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US livestock projections
• Commercial young chickens projected higher year on year for next 10 years
 - Very active buyer interest on poultry meats
 - Short flock regrowth after disease or disappearances (5-7 weeks)

• Commercial pork projected higher following slight drop in 2026
 - 5-7 months to market ready
 - Building new structures 
 - Proposition 12 in California and other states

• Commercial beef projected lower until a bottom in 2027
 - Slow herd rebuilding (18-22 months)
 - Producer margins started 2026 at $(35)
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Total US animal protein production

9%
Total poultry by-product 
production for 2025 is 8.7% above 
2024. 

Meat meal made up 47.5% of total 
production. Down from 51.1% in 
2024
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42%
Poultry meal made up 42.1% of 
total production. Up from 38.9% in 
2024.
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US export: IE MM and FM

Meat meal, meat and bonemeal, and 

DRT: 2025 volume (tonne)
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Feathermeal: 2025 YTD

volume (tonne)

2025 total Change from 2024

China – 180,485 -6.1%

Indonesia – 209,737 +13.4%

Mexico – 148,086 +15.8%

Vietnam – 331,123 +37.9%

Ecuador – 80,531 +44.3%

2025 total Change from 2024

Indonesia – 40,913 -34.5%

Vietnam – 22,538 -56.6%

Chile – 33,613 -34.9%

China – 6,523 +12.2%
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Demand shift

New feed

US supply 

disruptions

China lower due to tariffs

Indonesia, Mexico, Vietnam 
absorbing displaced volumes 

Meat and bone meal increasingly 
used as a cost-effective protein 
substitute in aqua and poultry feed

HPAI disrupted poultry by-product 
supply

Lower feathermeal inclusion
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International and US export price overview

8

STEP-BY-STEP GUIDE TO DESIGNING THIS SLIDE

1. To create a new slide drag a duplicate/copy of this dummy slide in the thumbnails panel on the left

2. Select each placeholder image separately and press delete

3. Click the import icon in the image placeholder boxes to import your new images

4. Crop your image as desired using the image crop tool, try to create a visually engaging crop

5. Select the images and “Send to Back” under the Arrange menu

6. Make sure any text, logos or icons that should overlay the image are visible on top of the image

7. Type your new text into the text containers making sure to hold the text formatting

8. Check that the page number (bottom right) corresponds to the slide number in the thumbnail panel. 

If not, select the text in the page number text container, then select from the top menu: Insert > Slide Number

You can make a copy of the logo, logo icon, benchmark, etc to paste into your new slide 

– select from the top menu: View > Master > Slide Master

• Most international prices 
flat or under previous years

• Increased production from 
both Australia and Brazil

• Relative soybean meal price 
pressure

• Increased cost of freight

• Fishmeal demand is active 
and fishing has been 
limited in some regions
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Factors impacting US animal proteins

Cattle imports:
• New World Screwworm in Mexico diminishing 

US imports of cattle

Calf headcounts:
• US calf headcounts have continued to drop 

since the peak in 2018

Heifer slaughter:
• Though decreased in 2025; kept heifers will 

not calf until early 2027.

Animal viruses/diseases:
• Avian flu 
• Swine flu
• PRRS
• Screw worm

Soybean meal production:
• Soybean meal production expected to move 

higher year-on-year for the next 5 years, 
minimum
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Over 80% of European fat and proteins are 
Category 3 certified

 

CATEGORY 1 CATEGORY 2 CATEGORY 3

EUROPEAN 
CATEGORIZATION

Cat 1 (High Risk) 

Cat 2 (Medium Risk)

Cat 3 (Low Risk) – derived 
from healthy animals 

Source: European Fat Processors and Renderers Association (EFPRA)

16.2 MLN TONNES

3.2 MLN TONNES

0.7 MLN TONNES
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Porcine and avian fats and proteins dominate the European supply
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ANIMAL FATS AND PROTEINS USE 
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as part of the Annex IX B list feedstocks according to RED III, alongside used cooking oil 

around 10,000 tonnes - burned as a combustion fuel

of category 1 and 2 animal fats used to 
produce biofuels annually 

391,000 tonnes

Source: European Fat Processors and Renderers Association (EFPRA), 2024 data
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Source: European Fat Processors and Renderers Association (EFPRA), 2024 data

Category 3 fats use per industry
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Source: European Fat Processors and Renderers Association (EFPRA), 2024 data
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PET FOOD FERTILIZERS ANIMAL FEED AQUA FEED COMBUSTION

Category 3 proteins use per industry

Source: European Fat Processors and Renderers Association (EFPRA), 2024 data
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PROCESSED ANIMAL PROTEINS MARKET
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Source: Fastmarkets 
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European meat and bone meal vs 
Argentinian, Brazilian soymeal, €/tonne

Category 3 mixed meat and bone meal, 50% pro, exw Eastern 
Europe, €/tonne
Soymeal (Brazil), Hi Pro, 48%, cif Rotterdam, $/tonne

Soymeal (Argentina), Hi Pro, 49%, cif Rotterdam, $/tonne
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Poultry meal: Europe, Australia, United States, €/tonne

Poultry by-product meal, petfood grade, 65 Pro, delivered Australia

Category 3 poultry meal, 65% pro, exw Eastern Europe

Poultry by-product meal, pet food, 14 Ash 64 Pro, fob US Southeast

Poultry by-product meal, pet food, 14 Ash 64 Pro, fob US Mid-South

Soybean meal priced €102.18/t higher in Europe compared to MBM 
End-of-season supply shortages and futures volatility keep Argentinian meal prices high
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Source: Global Trade Tracker

European 2025 PAPs exports up 6% y-o-y at 1.16 million tonnes

HS code 230110: flours, meals and pellets, of meat or offal, unfit for human consumption; greaves  
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Source: European Commission

2025:

▪ Total poultry slaughter 7,109,980k heads (+3.43% y-o-y)

▪ Total pork slaughter 227,202k heads (+2.28% y-o-y)

▪ Total beef slaughter 21,095k heads (-5.75% y-o-y)
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EFPRA, European Commission

Processed animal protein use policy

Partial lifting of the feed ban – September 2021

The major change came with Commission Regulation (EU) 2021/1372, which partially lifted the PAP ban:

Allowed in the EU since 2021

Porcine PAP → poultry feed

Poultry PAP → pig feed

Insect PAP → pig & poultry feed

Ruminant collagen and gelatine → non-ruminant feed

Still prohibited

Any ruminant PAP → any farmed animal

Intra-species recycling (e.g. poultry to poultry, pig to pig)

Any PAP → ruminant feed

This framework remains in force today and applies across all EU Member States.
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ANIMAL FATS MARKET
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Source: Fastmarkets

Higher vegetable oil prices increase oleochemical, animal feed 
and pet food demand for category 3 animal fats
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Source: Fastmarkets
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Tallow methyl ester (TME) and category 1, 2 animal fat price comparison in €/tonne 

Biodiesel, TME, B100, fob Rotterdam Category 1 and 2 mixed animal fat, max 30% ffa, ddp Northwest Europe Spread

Biodiesel-feedstock spreads narrow on high feedstock prices

UCOME-UCO €293.82/tonne
RME-RSO €197.90/tonne
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Source: Global Trade Tracker 

Policy developments

▪ RED III implementation to end double-counting in the 
Netherlands

▪ Category 3 animal fat GHG savings score might be cut 
in half in the Netherlands (0.5 factor)

▪ Potential supply reductions (lower slaughter rates, 
meat export reductions, disease outbreaks)

▪ SAF demand remains minimal, voluntary market covers 
2% production mandate
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GHG savings score

Category 3 animal fat ≈ 80-90%

Category 1 animal fat ≈ 80%

Rapeseed oil ≈ 60%

2021 vs 2025 – 73% decrease
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US Animal Fats Market
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US animal fats markets: tightening supply and 
rising competition

• Animal fats are used across feed, pet food, 

oleochemicals, food uses, and biofuels

• Feed historically represented the largest outlet 

for rendered fats

• Biofuels have rapidly grown to become the 

dominant demand segment as renewable diesel 

capacity expanded

• Feed and pet food buyers now compete with fuel 

producers for a limited supply of fats

• As a result, animal fat prices are increasingly 

influenced by energy markets and fuel policy
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Biofuels driving 

structural demand for 

fats

▪ Soybean oil remains the largest US biofuel 

feedstock, accounting for roughly35-40% 

of inputs.

▪ Animal fats are gaining share as renewable diesel 

producers favor lower carbon intensity 

feedstocks.

▪ As by-products of meat production, animal fats 

often deliver lower lifecycle emissions than crop-

based oils.

▪ Renewable diesel producers can shift between 

feedstocks based on carbon intensity and relative 

pricing.

▪ Higher prices for one fat — including UCO — can 

pull other animal fats higher across the market.

▪ Growing renewable diesel and emerging SAF 

demand are increasing competition for these 

feedstocks.
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Policy and energy signals now move animal fat 
markets faster than traditional feed demand
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• Animal fat prices are increasingly tied to 

energy markets and renewable diesel 

economics

• 2022 energy rally lifted fats prices 

alongside diesel and vegetable oils

• Prices weakened in 2024–2025 as 

renewable diesel margins declined

• Policy uncertainty — delayed RVOs and 

early 45Z guidance — weighed on 

markets

• Shift from the $1/gal tax credit to the 

lower-value 45Z credit reduced fuel 

revenues

• Recent conflict in Iran and the Middle 

East has supported diesel and fats prices

• Policy shifts have also changed soybean 

oil’s competitiveness in biofuels
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Livestock cycles limit growth in rendered fat supply

.

• Animal fat supply is determined by 

livestock slaughter, not price signals

• US cattle slaughter has declined 

following several years of herd 

liquidation

• Weekly slaughter rates have 

remained consistently below year-

ago levels

• Higher carcass weights have only 

partially offset lower cattle numbers

• Cattle supply responds slowly due 

to multi-year herd rebuilding cycles

• Limited supply growth comes as 

biofuel demand continues to expand
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Imports: Filling the supply gap

.

• Imports became a key balancing supply 

source as renewable diesel demand 

outpaced domestic production

• US UCO imports more than doubled 

from ~1 MMT in 2021 to ~2.4 MMT in 

2024

• Brazil emerged as the largest supplier of 

imported tallow to the US

• August 2025 tariffs on Brazilian tallow 

disrupted a major trade flow

• 45Z rules limiting foreign feedstocks 

create additional barriers for imports

• Despite policy headwinds, imports may 

persist due to RD infrastructure

• Recent tariff reductions (~10%), 

arbitrage opportunities have renewed 

interest in Latin American and Australian 

supply
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Feedstock demand implied by RFS 
biomass-based diesel volumes

Imports’ share of biofuel 
feedstock supply

33

~45B lbs

30-40%

~15B lbs
Total US animal fat supply

>300% 
Growth in renewable diesel 

capacity since 2020

Biofuel Policy Driving Animal Fat Demand

Small Refinery Exemptions (SREs)

• Exemptions reduce individual refinery obligations under the RFS

• EPA increasingly reallocates exempted volumes back into the mandate

• ~1.3–1.4B gallons of SRE reallocation included in the 2026 proposal

• Supports overall demand by preventing mandate erosion

Renewable Fuel Standard (RFS / RVO)

• Proposed 2026 RFS includes ~5.6B gallons of biomass-based diesel (~40–45B 

lbs feedstock demand)

• Establishes the baseline level of biofuel demand in the US market

• Biodiesel and renewable diesel generate D4 RINs, linking fats demand to fuel 

margins, and reinforces biofuels as the dominant demand driver for animal fats

• Proposed “half-RIN” treatment for foreign feedstocks discourages imports

45Z Clean Fuel Production Credit

• Replaced the $1/gal blender’s tax credit in 2025, tying incentives to lifecycle 

GHG reductions

• Eligibility limited to US, Canada, and Mexico feedstocks, effectively excluding 

most foreign fats and oils

• Narrows the advantage of very low-CI feedstocks, bringing soybean oil closer to 

parity

• Acts as an effective “penalty” on imports, impacting global trade flows
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Chloe Krimmel
Senior Price Reporter: 
Animal Proteins
Chloe.Krimmel@fastmarke
ts.com
(US) +1 (732) 642-6302

Fastmarkets Animal Fats & Proteins Team
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DDP North-West Europe 

Category 1 and 2 mixed animal fat max 30% ffa

Category 3 mixed animal fat max 15% ffa

Category 3 pure beef tallow 10% ffa

Poultry fat 8% ffa

Category 3 bone fat, 5% ffa

Category 3 bone fat high grade, 5% ffa, 200 ppm polyethylene

Poultry fat 2% ffa

Edible beef tallow 2% ffa

Edible lard 1.5% ffa

EXW Eastern Europe

Category 3 mixed meat and bone meal, 50% pro 

Category 3 poultry meal, 65% pro 

CURRENT ASSESSMENTS IN THE 

EUROPEAN MARKET
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